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File 

Open Exam
Use this menu to choose the exam you want to take.    If you want to quit without opening a 
new exam just click on the Cancel button.    If you need help click on the Help button to 
display detailed instructions.

See Selecting Exams for more information.

Print Exam
Use this menu to print your exam on paper.    This menu allows you to choose the default 
printer, portrait or landscape orientation, paper size and the paper source (this depends on 
which printer you are using).    Click on the OK button to print the currently loaded exam 
using the default printer.    Click on Cancel to quit without printing the exam.

See Printing Exams for more information.

Change User Name
Choose this item to change the user name without having to exit Examiner.    If the desired 
user name does not exist you can create it using this option.    You may also use this option 
to delete a user name.

See User Names for more information.

Exit
Choose this item to quit Examiner.    The current users grades will be updated.



Utilities 

Enter Password
Click here to enter your password.    You may not use the menu items under Utilities unless 
you have entered a valid password.    Initially, the password will be set to seven.    However, 
you may change the password.

Change Password
Click here to change your password.    This software comes with the password set to seven 
but you may change it to any other text you want.    You should do this to prevent your 
students from using the Utilities options to find the answers or make changes to your exams.

Make/Edit Questions
Use this menu to create new questions or to edit existing ones.    See Making/Editing 
Questions for more information.

Make/Edit Exams
Use this menu to make new exams or edit existing exams.    After you open this menu you 
should either open an existing exam to edit using the Open button or you should type the 
name of the exam you are creating in the Exam Name text box.

See Making/Editing Exams for more information.

Convert DOS Exam File
Use this option to convert School-Mom for DOS exam files to the format used by this 
program.    You will be asked for a directory in which to store the converted exam files.    If 
you want to create a new directory to store the converted exams you can use File Manager 
to do so. See the page    Selecting Exams for more information on how to access exams in
sub-directories.

The original DOS exam files will have an .EX2 extension.    However, if they are from an older
version of School-Mom they will have an .EXM extension.    If they are from the older version 
need to use the DOS program, EXAMCONV.EXE, to first convert them to .EX2 files.    You will 
find this program in the directory with this program.    Simply run the program and it will look
for any old exam files and convert them automatically.

Export Compiled Questions
This program should come with at least one exam that is compiled with a .DLL extension.    
These are exams supplied by the authors.    If you want to use some of the questions located 
in these exams in your own exams you must first export the compiled questions.

You will be asked for a directory in which to store the exported question files.    If you want to
create a new directory to store the converted exams you can use File Manager to do so.



Note that all this option does is export the questions from the compiled exam, it does not 
create an exam to use the questions. See the Make/Edit Exams item a few 
paragraphs above this one for details on how to create an exam to use these exported 
questions.

Fill-in-the-Blank
Choose this option if you want your student to type the answer in the blank.    No choices will
be shown for him/her to choose from.

Multiple Choice
Choose this option if you want your student to see a list of answers.    Your student will be 
allowed to select the correct answer by pressing the corresponding number key or by using 
the mouse to drag the correct answer to the blank.

Allow Guessing
Click here if you want to allow your student to continue looking for the correct answer even 
after choosing the wrong answer.    If you do not choose this option, your student will not be 
allowed to attempt the question again after choosing the wrong answer.



Options 
Voices On/Off
To turn off the voices select this item.    To turn the voices back on select this item again.    
Voices are used for reinforcements.

See Voices for more information about voices in this software.

Font
This menu allows you to choose any font you may have installed in Windows.    You may also 
change the font size.    However, this software will not allow you to choose a font size that is 
too large for the screen.



Help 
The Help menu is where instructive information is contained.    The options 
are:

Help Contents
This option is the option your are now using.    It may be invoked at any time by pressing the 
F1  function key.

Help on Help
This option invokes the Windows instructions on how to use the HELP utility.

View Description of other Products from MES...
This option invokes Windows Write Editor with a file containing descriptions of other 
educational software available from Motes Educational Software.

About Examiner...
This option brings up a dialog box with miscellaneous information about this program.



Shortcut Keys 
There are several shortcut keys that can make the operation of Examiner 
more convenient.

Right Arrow: pressing the right arrow button is the same as clicking on the Next Question 
Button. See also Next Question Button

Left Arrow: pressing the left arrow button is the same as clicking on the Previous Question 
Button. See also: Previous Question Button

Esc (Escape): Pressing the Esc key will abort the dragging of an answer to a blank.    This is 
useful if you click on the wrong answer by mistake and realize it before you drop the answer 
into the blank. After pressing the Esc key you may attempt to answer the problem again.    
However, once you drop the answer into the blank the Esc key will not undo a wrong answer.



Selecting Exams
You can use the Open Exam option in the File menu to choose an exam to take.    You may 
choose a compiled exam that is created and distributed by MES as a dynamic link library 
(DLL), or a user-made exam that you have created.    Initially, both types of exams are shown
but by clicking on the proper option button the listed types can be limited to one or the 
other type.

Now, you should see a list box that shows all the exams you can choose from.    Highlight the
one you want then click on the OK button to open the exam.    You may also double click on 
the exam you want.

To load exams from another directory you can change the directory by using the listbox on 
the right hand side of the screen.    This dialogs works just like the standard File Open… 
dialog.



Taking the Exam
After you open an exam using Open Exam in the File menu and return to the main window, 
you should be ready to take the exam.    You will not be able to begin the test unless you tell 
the computer to start the timer.    Do this by using the mouse to click on the Start button.

The first question should now be visible.    Choose the correct answer by either using the 
mouse to drag the correct answer to the empty blank or by pressing the corresponding key 
on the keyboard.

To get the next question you must click on the button in the lower right of the screen that 
looks like a hand pointing to the right.

After you have finished the exam your grade report will be shown.



Printing Exams
Choose the Print Exam option from the File menu if you want to print a paper copy of your 
exam.    You may want to do this to give an in-class exam. 

You may print with portrait orientation (the standard orientation).    You may also print with 
landscape orientation which rotates the printed page 90 degrees.

Click on the OK button to print the currently loaded exam using the default printer.    Click on 
Cancel to quit without printing the exam.

If you want to see other adjustments you can make to your printer before you print the 
exams click on the Options button.    What comes up after you do this depends on what 
printer you are using.



Making/Editing Questions
(This dialog has brief instructions in a scrollable list box at the bottom of the 
dialog)

To make or edit questions choose the Make/Edit Questions option from the Utilities menu.    
You will have two main text fields or boxes to type in -- the Background Text box and 
Question Text box.    The Background Text box is optional and allows you to provide the 
student with background information that you do not want to place in the question.

If you want to create a fill-in-the-blank test, place a single underscore in the text where you 
want the blank to occur in the question.    If you do not place an underscore in your question,
a blank will be placed at the end of your questions.    You may place one or two blanks in 
each question.

To properly organize your questions (you may want to sort them later) you should always 
type the subject, grade, and year in the text boxes provided for these.    There is also a 
miscellaneous text box that you can use.    Later you can use this information to sort your 
questions or to do searches.    For example, you may have hundreds of questions stored but 
you want to give a science test to your 3rd graders.    When you are ready to create a test 
just have the program display all questions that have science for the subject and 3 for the 
grade.

To add questions, type the question in the text box (List A if you have one answer or both 
List A and List B if you have two answers) then click the Add button.    The answer will be 
added to the list box shown directly below the Add and Remove buttons.    Add several 
answers that are not correct using the same procedure.    When you are done make sure the 
answer that is correct is highlighted and is showing in the answer text box.    To highlight the 
correct answer just click once on the correct answer that is listed in the list box with all the 
possible answers.

To preview the question just click on the Preview button.    You will see the entire question 
with all possible answers.

Click the Save button to save your question.    Remember that the correct answers must be 
highlighted before you click on this button.

Click the Cancel button to quit without saving your question or click Help to display this help 
text.

If you want to edit an existing question just click on the Open button and choose from the 
list of questions shown.    Highlight the question you want to edit then click on the OK button.
The question you chose will be displayed ready for editing.



Making/Editing Exams
After you open the Make/Edit Exams dialog from the Utilities menu, look under the 
Available Questions text box to see a list of all the questions that are located in the current 
directory. If you want to see questions in another directory then click on the Change Dir. 
button and select a new directory.    Remember though, that only questions in the same 
directory can be placed into an exam.

You can load an exam for editing by clicking the Open Exam button, the questions in the 
exam    are shown in the list-box under the exam name. You can move questions from the list
of available questions to the list of exam questions by highlighting the questions then 
clicking on the >> button.    To remove a question from the exam simply highlight it and click
on the << button.

You can create an exam by typing in a filename in the Exam Name text-field. The exam is 
not saved until you save it by clicking on the Save Exam button.

To view a question that is listed just highlight its name.    You will see the question and its 
answers at the bottom of the screen.

You can edit a question by highlighting its name and then clicking on the Edit Question 
button directly below the list-box of the question you want to edit.    There are two Edit 
Question buttons, be sure to click the correct one.

The list of available questions can be sorted by subject, grade, year and any other thing you 
may have typed into the miscellaneous field.    Use the drop-down lists to choose text to sort 
by.    If the sorting category you need is not there you may use the Add Category button to 
add it.

After you add all the questions you want to the exam, save your exam before you exit the 
Make/Edit Exams menu.



Next Question Button
This button looks like a hand pointing to the right.    You may use this button at any time to 
abandon the current question and go on to the next question.    This DOES NOT increment 
the number of questions attempted and will affect your current score.

Pressing the right arrow button on the keyboard is a shortcut to clicking on this button with 
the mouse. For more details about special keys, see: Special Keys 



Previous Question Button
This button looks like a hand pointing to the left.    You may use this button to abandon the 
current question and go to the previous question.    This DOES NOT increment the number of 
questions attempted and will not affect your score.

Pressing the left arrow button on the keyboard is a shortcut to clicking on this button with 
the mouse. For more details about special keys, see: Special Keys 



Grade Report
After you complete an exam your grade report is given.    You will be given a numeric score 
and a letter grade.    Also, you will be shown all the correct answers to the exam along with 
the answers you gave.

There are three buttons at the bottom of the dialog.    Pressing the OK button will dismiss the
dialog.    Pressing the Produce Save-able Report button will place the information in the 
dialog in the file REPORT.TXT and open Windows Notepad to view this file.    Notepad can be 
used to either print the Grade Report or save the report to another file.    The file REPORT.TXT
is overwritten each time the Produce Save-able Report button is clicked.    Be sure to save 
your reports in a filename other than REPORT.TXT.

Pressing the Help button brings up this information page.



User Names
To change the user name see the File item.    This item will produce a dialog box that will 
allow the user name to be changed from the current user to another already existing user 
name.    It will allow creation of a new user name or deleting an existing user name.

On the left hand side of the dialog is a list box from which the user name can be selected.    If
there are more user names than can be displayed at one time a scroll bar will appear on the 
list box so that more user names can be brought into view.    On the right are five 
pushbuttons.    Press the OK button after the user name is chosen.    The CANCEL button 
cancels the current change user name operation, however, pressing CANCEL will not undo 
the creation of new user names or undelete user names that have already been deleted.

The NEW button creates a new user name, a text entry dialog will be displayed to accept the
new user name.    The DELETE button deletes the user name currently selected in the list 
box.    Confirmation is obtained before the user name is deleted.

The HELP button brings up this information page.



Voices
To turn voices on or off see the Options  item.

Examiner for Windows has the ability to give verbal feedback.    These voices are played 
through the Windows WAV sound driver.    If you own a Sound board you should have the 
sound board driver installed in Windows, see your Sound Board and Windows Documentation
for detailed instructions.

If you do not have a sound board there is still a way for you to activate the voices through 
the PC internal speaker.    While the quality is not as good as a sound board the result has 
enough clarity to be recognizable and useful.    To do this you must install a PC speaker driver
in Windows.



Changing the Current Directory
Several operations in Examiner become much more useful if you are allowed to change the 
current directory.    For example, storing exams and questions in sub-directories by grade is a
very useful way of organizing exams.

There is a special dialog in Examiner to allow you to easily change the current directory and 
browse the hard disk for certain questions or exams.    The operation of this dialog is very 
similar to the standard File Open dialog.

If you press the Cancel button it will completely undo any browsing activity.

See Also: Making/Editing Exams



Other Educational Products from MES
Examiner is the sixth of a series of educational software applications from Motes Educational
Software (MES) for Microsoft Windows.    MES also has a successful line of educational 
software for DOS that has won various awards from the educational software community.      
If you would like to receive more information about MES products, please contact MES 
through one of the means listed below.

In addition, MES offers educational software for both DOS and Windows environments.    To 
view a brief description of the software available at this time choose the Help|View 
Description of Other Products from MES... menu item.

You may write to MES at the following addresses:

U.S. Mail: Motes Educational Software
P. O. Box 575
Siloam Springs AR, 72761

Electronic Mail: 73757,1111              on CompuServe

or from Internet 73757.1111@compuserve.com 

MES maintains an internet web site where you may find updated information about new 
products and new versions of existing products. The URL address is: 

http://ourworld.compuserve.com/homepages/schoolmom
See you on the World Wide Web!




